
ArcGIS Pro – Session One 
 

Creating Your First Map 
 
The following step-by-step guide will help you to create a generic map using ArcGIS Pro (Pro), 
and some best practices for storing data, file management, and naming convetions. 
 
During the process you will be making an Pro “Project”. This Project will consist of several files and 
folders including a “File Geodatabase”. You will create a “Feature Dataset” to store features. 
The Feature Dataset is nested inside of the File Geodatabase. 
 
You will also find and download data using the internet. For Session One this original data will be 
in the form of a shapefile, which has become a Geographic Information System (GIS) industry 
standard file format. You will then “import” (copy) this data into the Feature Dataset that was 
created. Once that import is complete, the shapefiles become “Feature Classes”, and along 
with that new designation, they gain some extra functionality that may be explored at a later 
time.  
 
During this session, you will also be shown some styling options to help create a more meaningful 
graphic representation of your data. You will then create a Layout and be able to share this with 
others. 
 
Please note that ArcGIS software updates regularly and images may not be completely 
accurate to your screen view. Every attempt has been made to make the images as accurate 
as possible. 
 

 



 

 

 



Once installed, ArcGIS Pro Software is found in the Start Menu inside of a Folder titled ArcGIS. 

1. Click once to open ArcGIS Pro. 

 

 

 

 

 

 

 



2. Sign in with your ArcGIS Online account information. (usually - firstname.lastname). 

 

 

 

 

 

 

 

 

 



3. Near the center of the screen choose “Start without a Templae (you can save it later)”. 

 

4. The initial user interface is displayed. 

 



5. On the right-hand side of the screen expand “Databases” and then hover on 
“Default.gdb”. This will display the path of that Geodatabase (File Geodatabase) - 
Green text. Take note it is inside of a Temp folder for the time being. 

 

6. Using Windows File Explorer, navigate to the C Drive and right-click to create a New 
Folder. 

 

 



7. Name this new folder “Working Folder”. 

 

8. Click the Project Tab at the upper left. 

 

 

 

 

 

 

 

 

 

 

 



9. Select “Options”. 

 

 

 

 

 

 

 

 

 



10. Under ‘Application’ select ‘General’. 

 
 

 

 

 

 

 

 

 

 

 

 

 



11. Choose the Dark Application Theme 

 

12. A message will display but do not bother to restart ArcGIS Pro just yet – Please wait a few 
steps. 

 

 



13. Choose Save As and navigate to the Working Folder on the C Drive. 

 

 

 

 

 

 

 

 



14. Notice how ArcGIS Pro tries to name the Project for you based on the folder you are in. 
This is because a Pro Project is really a set of files and folders that all work together. 
Therefore, a Folder is needed to house them all. ArcGIS Pro tries to do this for you at the 
start of each project. 

 
 

 

 

 

 

 

 

 

 



15. Right-click in the center window and create a new folder. 

 

 

 

 

 

 

 

 

 

 

 



16. Name this new folder the generic name “New Folder” – then click Save. 

 

 

 

 

 

 

 

 

 

 



17. Back in ArcGIS Pro expand the Default.gdb then inspect the new path to the source. 
(C:\\Working Folder\New Folder) 

                           

 

 

 

 

 

 

 

 

 

 

 



18. Close ArcGIS Pro.                                                                                                            

 

 

 

 

 

 

 

 

 

 



19. Navigate to “New Folder” to inspect the files and folders that Pro creates. Notice that the 
ArcGIS Project File name is “New Folder” and it is inside of the folder of the same name. 
This becomes important later when trying to manage all the files of a project. There are 
other files and folders in this folder, but are only space holders at this time.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 



20. Back up one folder in Windows File Explorer and create another new folder. 

 

 

 

 

 

 

 

 



21. Name this new folder “Two” to help us remember. 

 

22. Select all of the files and folders for the ArcGIS Pro Project and choose to ‘Cut’ them 
instead of Copy. 

 

 



23. Paste all of these files and folders into the newly created folder titled “Two”. 

 

24. Rename the ArcGIS Pro Project file to “Session One Project” at this time. 

 



25. Double-click the ArcGIS Pro project to open it. Observe how the display now has the 
Dark theme applied. 

 

 

 

 

 

 

 

 

 

 

 

 



26. Expand “Databases” and hover on the Default.gdb to see the path to the source. Notice 
that Pro has remapped to the new location with zero effort by you. This is important to 
remember. The possibility exists that a user can be making edits in a data set, but in 
reality, the most current data can be in another location. It is wise to double check the 
source prior to any editing or sharing of data. 

 

 

 

 

 

 

 

 

 

 



27. Right-click the Default.gdb. 

 

 

 

 

 

 



28. Hover on “New”. 

 

 

 

 

 

 



29. Choose “Feature Dataset”. 

 

 

 

 

 



30. On the right side of the screen name the Feature Dataset to 
“Session_One_Feature_Dataset”. Please Note: This name cannot contain any spaces and 
special characters are also limited. 

 

 

 

 

 



31. Click the small globe to the right of Coordinate System. 

 

 

 

 

 

 



32. Expand Projected Coordinate System. 

 

 

 

 

 

 

 

 

 



33. Expand UTM. 

 

 

 

 

 

 

 

 

 



34. Expand NAD 1983. 

 

 

 

 

 

 

 

 

 



35. Choose “NAD 1983 UTM Zone 14” by clicking just once. 

 

36. Click the small Yellow Star at the right to add it to your Favorites. This way you won’t have 
to hunt for it again. 

 

 



37. “NAD 1983 UTM Zone 14N” is now the current coordinate system which will be assigned to 
the Feature Dataset we are creating. 

 

 

 

 

 

 

 

 

 

 

 



38. Click the Run button at the bottom right of the GeoProcessing Tab. 

 

 

 

 

 

 



39. The Geoprocessing tool runs and completes with no warnings. 

 

 

 

 

 

 

 

 

 

 

 

 



40. Click the Catalog tab at the bottom of the window. 

 

 

 

 

 

 



41. Observe the new structure in the Catalog Pane for this project. The 
Session_One_Feature_Dataset will be inside of the geodatabase (Default.gdb). 

 

42. Right-click on “Folders” and choose “New Folder Connection”. 

 



43. Navigate to the Downloads Folder and then create a new folder titled “Downloads for 
Session One”. Click OK to connect to that new folder. The naming conventions you 
choose can be helpful to determine file locations later on during times when you have a 
very complex Project that pulls data from numerous sources. 

 

 

 

 

 

 

 

 

 



44. Observe the new connection in the Catalog Pane. Please note that a Pro Project does 
not have to be contained in the folder that you, and Pro, have created. Data can come 
from nearly any source location and be in many different formats. The small ‘House’ icon 
shows the default items, however. 

 

 

 

 

 

 

 

 

 

 

 



45. Right-click the “Downloads for Session One” folder then choose “Add to Favorites. 

 

46. Click the Favorites Tab to see the new connection there. This can easily be added to any 
subsequent ArcGIS Pro Project. This is helpful since you can keep all of your most used 
items in on location. There will be no need to ‘re-source’ the files. Instead, simply add 
them to any new project. 

 



47. Using an internet browser navigate to the NGPC Open Data Portal. 
 
https://data-outdoornebraska.opendata.arcgis.com  

 

 

 

 

 

 

 

 

 

 

 

 

https://data-outdoornebraska.opendata.arcgis.com/


48. Scroll down the page and locate the “Parks” icon. 

 

49. On the next page, click the orange text for State Park Areas. 

 



50. Click the small download button to copy the data to your local machine. 
(76 records in this dataset) 

 

 

 

 

 

 



51. Perform the same download steps for “Nebraska State Trails”. Go back one web page to 
find the layer, then click the orange text for Nebraska State Trails. 
(476 records in this dataset) 

 



52. Copy the compressed files From your downloads folder into the folder we created called 
“Downloads for Session One”. Remember that ArcGIS Pro is already connected to this 
folder. 

 

 

 

 

 

 

 

 

 

 

 

 

 



53. Exctract all of the compressed files to this location. 

 

 



54. Back in ArcGIS Pro, right-click the Working Folder and select “Refresh”. This reconnects 
the link to the folder and will display new content. 

 

 

 

 

 

 

 

 

 

 

 

 



55. Expand the folders for Nebraska_State_Trails and State Park_Areas as far as possible. 
Then, right-click on the files with extension “.shp” and choose, “Add To New Map” for the 
first .shp that you choose, then “Add to Current Map” for the second .shp file. The order 
in which you add these to a map does not matter. 

 

 

 

 



56. The overall “Map View”. Note: this is still the defaut projection and coordinate system – 
Can be changed in the Options like was done to change to a Dark Theme. We will 
change this Projection momentarily. 

 

 

 

 

 

 

 

 

 

 

 



57. Right-click on the Feature Dataset created earlier. Then hover on “Import” and choose 
“Feature Class(es)”. 

 

 

 

 

 



58. Using the drop down arrows in the Geoprocessing tab, choose each of the Layers 
already added into the Table of Contents then click Run at the bottom right of the 
screen. 

 

 

 

 

 

 



59. Once the import process completes there will be two new “Feature Classes” inside the 
Feature Dataset. These are no longer ‘shapefiles’. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



60. Select both of these “Feature Classes” then right click and choose, “Add to New” – then 
choose Map. 

 

 

 

 

 

 

 

 

 

 



61. Notice this Map View, “Map1”, is projected and has those Feature Classes from the 
Feature Dataset. The Feature Classes inherit the Projection from the Feature Dataset. 

 

 

 

 

 

 

 

 

 

 

 



62. Zoom to Fort Robinson State Park in the northwest portion of Nebraska. Notice there is 
already a ‘Base Map’ below the feature layers that have been added. 
 
Also notice that the Area Feature of State_Park_Areas is below the lines of 
Nebraska_State_Trails. If we had added any point features they would have been 
placed above the lines. This is usually the order in which items are placed into the Table 
of Contents, but they can be rearranged as needed.  
 
Please Note: Some items may be hidden from view if placed underneath other features in 
the Table of Contents on the left side of the screen. 

 

 

 

 

 

 

 

 



63. Click the small colored square underneath the layer for “State_Park_Areas”. A new tab 
on the right side of the screen will appear. 

 

 

 

 

 

 



64. The Symbology Tab appears and there are many default color styles to choose from in 
the “Gallery”. 

 



65. Clicking on Properties shows the various color schemes and overall appearance of the 
layer. Items such as Opacity and Stroke Width can be changed here using the small 
wrench icon or the icon that appears like “layers”. 

 



66. Notice the stroke style here for the trails layer has been altered to be a ‘Multi-line’ layer. 
This allows for a ‘casing’ to be displayed around each of the lines. 

Again, clicking on Properties shows the various color schemes and overall appearance 
of the layer. Items such as Opacity and line thickness can be controlled. Or, click on 
Gallery and choose a preexisting style. 

 Experiment with the styling options of the layers. 

Once you are satisifed with the color, thickness, and opacity you may save this to your 
‘Favorites’ by clicking the ‘Hamburger’ icon at the right corner. Even unique color 
options can be saved to a color pallette and shared with others. 

 

 

 

 

 

 

 

 



67. Select the Insert tab at the top near the left and choose “New Layout”. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



68. Pick a size for the finished artwork. This can be altered layer, if needed, but please note 
that any size can be printed ‘to fit’ any size of paper if needed. 

 

 

 

 

 

 

 



69. Fine tune the Layout Properties as needed. Portrait orientation and Landscape are easily 
swithched here. 

 



70. Once the Layout View is created click Map Frame at the top.

 

 

 

 

 

 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 



71. Choose “Map1”, not “Map” – While the layers are similar, they do not display the same 
data any longer. We have imported those layers to a new Feature Dataset and 
Geodatabase, and reprojected them, but this was done in the “Map1” Data Frame. We 
have also spent time styling those layers as needed. 

 

 

 



72. Click and Drag a Box on the Layout View. Once you release the mouse button a general 
map will be placed. Do not worry about placement, size, or scale at this time. All of these 
properties can be adjusted later. For now we just need something on the Layout to work 
with. 

 

 

 

 

 

 

 



73. Right-clicking on the rulers lets you place guide lines to help with a Layout. 

 

 

 

 

 

 

 

 

 

 

 



74. The guides here are placed at 1/8 inch and 1/4 inch on all four sides, and another guide 
was placed at 1/2 inch along the top. 

 

 

 

 

 

 



75. On the Insert Tab, look to the right and select “Rectangle”. Then draw a rectangle to act 
as a neatline around the map. Click and drag the mouse to do so. Again, do not worry 
too much about placement, it will be adjusted later. 

 

76. Here the map is placed completely off of the Layout sheet. It will be adjusted later. 

 



77. Click on “Straight Text” option to then place a Title. 

 

 

 

 

 

 

 

 

 

 

 

 

 



78. Once a feature is selected, its properties can be adjusted. 

 

 

 

 

 

 



79. Selecting a size for the text. Notice this is under the “Text Symbol” option near the top of 
this window. 

 

 

 

 

 



80. Clicking the corners of the rectangle allows for dragging to the guide line corners. 

 

 

 

 



81. Select all of the features on the map followed by a right-click. One can align to the 
center easily. 

 

 

 

 

 

 

 

 

 

 



82. Once the map frame is selected, it can be activated for panning and zooming after a 
right-click. 

 

 

 

 

 



83. To close the activated map, you must navigate to the Layout Tab followed by the 
selection of “Close Activation”. 

 

 

 

 

 

 

 

 



84. Make sure the Map Frame is selected then add in a North Arrow, Scale Bar, and Legend. 
 

 

 

85. Press Save. Please note that Pro will continually ‘back up’ your progress, but that feature 
should NOT be depended upon. Please save often. The shortcut to save, like many other 
software programs is ‘control-s’.  

 



86. Double-click the Trails layer and choose “Definition Query”. This option allows for the 
filtering of data. You may create a Query by using the drop down arrows and that 
Graphic User Interface (GUI), or by typing in Spatial Query Language. 
 
Here, only the features that have the attribute “shape_length” of greater than 5000 units 
will be displayed. 
 
At a later time we will cover the Attributes in more detail. 

 

 

 

 

 

 

 

 

 



87. Fewer Trails are displayed. 

 

 

 

 

 

 

 

 



88. After clicking the Share Tab at the top you may export your layout to a variety of formats. 

 

89. Here, ‘PDF’ is selected as the export format. 

 



90. Save and Close Pro. 
 

91. Locate your exported PDF and open the document. 

 

 



 


